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Pre-requisites 
 
 
Before running the DPODSPT application software, please ensure that: 
 
• Allow a minimum of 20 minutes warm-up time for oscilloscope. . 

• The oscilloscope should have SPC (Signal Path Compensation) run to assure 
accuracy of the acquisition system. Remove all probes from the scope before 
running SPC.  

• Perform de-skew to compensate for skew between measurement channels. Note 
that it is critical to select “Off” for the “Display Only” control on the de-skew setup 
window. This will assure that the de-skew data is stored with any waveforms that are 
stored. 

• Any unused connections on the DisplayPort test fixture should be terminated using 
50-Ohm terminators. 

• Up-to-date versions of the TekScope and DPOJET applications are required to 
ensure best operation of this software. The “readme” file for DPODSPT has 
information on the required versions.  Please ensure that these versions (or later) are 
installed on your oscilloscope and update them from Tektronix.com if necessary. 

• 100Mb available hard drive space recommended 

• DPO70804, DSA70804 or higher-bandwidth model of DPO/DSA oscilloscope is 
required 

 

 
Note: A secondary monitor is recommended (but not necessary) to display the scope 
application and DisplayPort application individually/separately. 
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Instrument Connection 
 
 
The DPODSPT software can perform testing on a connected device-under-test (“DUT”) 
or on stored waveforms that have been acquired previously. Direct connection to the 
DUT (Device-Under-Test) requires at least one skew-matched pair of SMA cables and 
the DisplayPort test fixture. The test fixture is available from Tektronix as part # ET-DP-
TPA-STX.  Differential probes P7380SMA or P7313SMA can also be used, and include 
their own phase-matched SMA cable sets. If probes are not used, phase-matched SMA 
cable sets are available from Tektronix as part # 174-4944-01. 
 
When using a direct connection of SMA cables to the oscilloscope inputs, CH1 and CH2 
of the oscilloscope should be connected to the DisplayPort lane to be tested. 
Oscilloscope CH3 and CH4 can optionally be connected to another DisplayPort lane for 
inter-pair skew testing.  Any unused connections on the DisplayPort test fixture should 
be terminated using 50-Ohm terminators. 
 
 

 

        Figure 1: Transmitter test setup for compliance test using matched SMA Cable set.
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About the Application Software 
 
The DPODSPT application software has five tabs. 
 
“Configure” Tab: 
 
This tab shows the controls for configuring the test setup. It shows information about the 
connection between the oscilloscope and the DUT, which lane(s) are assigned to the 
oscilloscpe channels and types of signal that will be made available for the compliance 
tests. The selection of ‘supported signal types’ on the CONFIGURE tab will determine 
the list of available / applicable tests on the “SELECT” tab. The CONFIGURE tab also 
allows the user to select saved waveform files for testing in place of a connected DUT. 
Selecting the “Verbose Logging /Reporting” check box at the bottom of the screen will 
generate a detailed log file and adds additional screen shot information to the test report. 
 

 
 

Figure 2: “Configure” screen of DPODSPT application. 
 
“Supported signal types” checkboxes help the user to let the application know which type 
of signals will be made available to it for compliance testing. For example, having 0dB 
and 3.5dB checked in the “pre-emphasis” group indicates that the device-under-test can 
generate signals with these parameters and that they should be included in the test 
suite. Similarly, if signal with SSC enabled is not available, the user would uncheck the 
‘With SSC’ option, and the tests that require SSC will be bypassed. 
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”Select” Tab: 
 
This tab gives users the options of selecting the tests and assigning the test session with 
a DUT name and user comments. The DUT name and the user comments appear in the 
test report as well. A data file folder will be created using “DUT NAME” (as you enter it 
here) for the folder name, where waveforms and other data files will be stored for this 
test session. NOTE: If you use the same DUT name for successive test runs, the 
previous test result data will be overwritten. 
 

 
 

Figure 3: “Select” screen of DPODSPT application. 
 

 
The tree of tests can be expanded to select tests for a particular type of signal such as 
PRBS7 signal of 400mV amplitude and with 3.5dB of pre-emphasis level. The user can 
select/deselect all the tests of a branch by checking/un-checking the higher-level check 
box. The available selections include combinations that are not required for compliance; 
you can limit the measurement set by clicking the box titled “Select Only Required 
Compliance Tests.”  Some tests rely on other tests, and will automatically select them. 
 
Note 1:  The tree of tests is built based on the ‘supported signal types’ selected in the 
‘Configure’ tab. Any change in the ‘Configure’ tab resets the test selection. 
 
Note 2:  Stored waveforms and other test data may fill several GB of hard disk space 
from each test session. You may need to move data if running many test sessions. 
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“Acquire” Tab: 
 
This tab lists the required signals that need to be acquired, based on the test selection in 
the Select tab. Details about the required signal(s) such as type of pattern, data rate, 
pre-emphasis level, amplitude, SSC and oscilloscope channel (signal to be acquired 
from) are shown.  
 
The Acquire button is used to initiate the process of signal acquisition. The acquired 
signals are saved as ‘oscilloscope reference waveforms’ in the folder specified by the 
DUT name. (“c:\Program Files\Tektronix\DPODSPT\AAA_Display_Port”  where AAA = 
name provided for the device under test) 
 
 

 
 

Figure 4: “Acquire” screen of DPODSPT application. 
 
 
Note: Some of the signals can support multiple tests. The list of signals to be acquired 
doesn’t show such duplication of signals for multiple measurements. 
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When a user starts the acquisition by clicking on the Acquire button, a pop-up message 
box, as shown in figure 5, displays the signal being acquired.  Attributes of the signal to 
be acquired are displayed. 
 
There are four buttons provided in this dialogue box. 
 
Abort Test: Clicking this button will abort the entire test session. No acquisition takes 
place. 
 
Skip: Clicking this button will skip acquisition of this signal and move to the next signal 
type to be acquired for this test session. Measurements that depend on the skipped 
signal type will not be performed. 
 
Check Signal: Clicking this button will manually validate the signal i.e., it will compare 
and show the required and actual attributes of the signal acquired. If they do not match, 
an alert message is displayed for the user. One such comparison is shown in figure 5. 
 
Use Signal: Clicking this button will guide the application to acquire and use the 
acquired signal for the test. In this case signal validation takes place by default. In case 
of a mismatch between required and acquired signal attributes, the user will see a 
“warning” screen similar to Figure 5 below, and then has the option to change the DUT’s 
output signal or else let the application use the existing signal by clicking on the Use 
Signal button. 
 
 

 
 

Figure 5: Signal check during acquisition  
 

 
Note: Validation of the signal acquired against what is required happens by default for 
all the acquisitions. The “Check Signal” button is provided to manually invoke signal 
validation. 
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“Acquire” Tab (if using previously-stored waveforms): 
 
 

 

Figure 6: “Stored Files” dropdown menu  

If the user has selected the data source as “Stored Files” rather than “Connect to 
DUT” in the Configure tab, then the Acquire tab will present a different set of choices.  
 
Instead of the “Acquire” button, in this case the user is presented with two choices - 
”Load Individual Files” and “Load All From Directory.” 
 
 

 
 

Figure 7: “Load Stored Files” opening screen  
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If the “Load Individual Files” button is pressed, a pop-up window appears with a 
description of the first signal type needed. Press the “Read Waveform” button and then 
navigate to the file to be used. The waveform file must meet signal conditions shown in 
the popup window.  
 
The user will find this step more convenient if they use a file naming convention that 
describes each signal’s parameters (e.g., “PRBS7_HBR_400mV _0dB.wfm”)   
If the waveform files were saved from an earlier test session using DPODSPT, the file 
naming conventions will automatically be compatible. 
 
 

 

 

Figure 8: “Load Individual Files” navigation screen  
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In cases where a large collection of waveform files have been previously saved, the 
“Load All From Directory” button can be a valuable option to help automate and speed 
testing. When this button is pressed, a pop-up window appears, allowing navigation to 
the folder where the files are stored. After the user points to a folder, the software will 
attempt to perform all the selected tests, using the waveform files in that folder. 
 
 

 

 

Figure 9: “Load All From Directory” navigation screen 
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“Analyze” Tab: 
 
Completion of signal acquisition automatically directs the application to this tab. This tab 
displays the sequence of tests that will automatically execute after all the necessary 
signals are acquired. The contents sequence of operations can be recorded into a log 
file by checking the ‘Verbose Logging /Reporting’ option on the Configure tab.  
 
 

 
 

Figure 10: “Analyze” screen showing test progress indicator 
 
 
 
A progress bar is used to show the progress of execution of the selected tests. 
 
Note: The ‘Run’ button is provided for re-running the tests with already acquired signals. 
If the user is acquiring a new set of signals using the ‘Acquire’ button, the tests are 
automatically executed at the end of the acquisition process. 
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“’Report” Tab: 
 
Completion of test execution automatically triggers the application to display this tab. 
The Report tab displays the results of the tests executed, in PDF format. Another test 
data report in .csv file format is also saved in the data file folder associated with this test 
session. 
 

 
 

Figure 11: “Report” screen of DPODSPT application. 
 

 
PDF report generated by DPODSPT application contains (A sample is shown in figure 
12 and figure 13): 

• Date and time of the test session (from the system clock) 
• Device / DUT name and User comments (as entered in the Select Tab) 
• Compliance test summary 
• Detailed test summary 
• Individual test results with necessary graphic(s) / plot(s) 

 
Note: The PDF report, .csv report, log file and waveforms used for the tests are stored / 
saved in the folder specified by DUT name: 
e.g., (c:\Program Files\TekApplications\DPODSPT\AAA_Display_Port) 
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How to perform compliance test using DPODSPT application: 
 
 

• Refer to “Instrument Connection” and “Pre-Requisites” above, to prepare the 
necessary instrument connection and preparation. 

• Launch the DPOJET application. Wait until you see DPOJET menu. 
• Start the DPODSPT application, from the “Analyze” menu in the oscilloscope 

main control menu. 
• The application will automatically detect what is connected to each oscilloscope 

input channel - either a differential probe or TCA-SMA adapter. The “Lane 
Assignment” section of the Configure tab will show the input configuration. 

• If using TCA-SMA connections, configure the lane assignment for the 
oscilloscope channels. 

• Based on the signals that will be supported / generated by the DUT, configure 
the options provided in the Configure tab. 

• To log the sequence of operation/test execution, verbose logging option should 
be checked. 

• Go to Select tab and choose the tests to be performed. The tree of tests can be 
expanded for detailed view by clicking on the “+” icon. 

• Enter the DUT name – The same name is assigned to the folder where all the 
waveforms (used for the tests), log file and final test report (PDF file) will be 
saved. 

• Any comment entered in the ‘User Comment’ section will be reflected in the final 
test report (PDF). 

• After selecting the tests that need to be performed, go to “Acquire” tab. This tab 
will list all the possible signals that need to be acquired for performing selected 
tests. 

• Click on the Acquire button to initiate the acquisition of signal(s). 
• The signals are validated against what is required. On the ‘acquisitions status 

dialogue’, click on ‘Use Signal’ button when you find the signal acquired is 
correct.  

• In case the signal acquired is not what is required for the test, then recheck your 
DUT setting/connection and validate the new signal by clicking on “Check Signal” 
button. Once you have the correct signal, click on “Use Signal” button to continue 
to next acquisition. If signal problems cannot be resolved, press the “Skip” 
button. 

• Keep changing the DUT setting / connection to feed appropriate test signals as 
prompted by the ‘acquisition status dialogue’. 

• Once all the signals are acquired, tests will automatically begin (if not, click on 
Run button in the “’Analyze” tab). 

• Test execution progress will be shown by the application as a separate popup 
window. Once the tests are executed, the report will be shown in the “Report” 
tab. 

• The waveforms and report will be available for post-analysis in the specified 
folder. 
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Appendix A: Scope/Probe/Cable Calibration 

 
Before beginning any test or data acquisition, the oscilloscope must be warmed 
up, calibrated, and cables de-skewed.  This section will include the procedure for 
calibrating the scope and de-skewing the cables. 
 
The DSA/DPO70000 series oscilloscope must be calibrated manually and this is 
recommended after a 20-minute warm-up period or whenever a new 
measurement session is going to begin. 
 
Calibration can be performed in the following order: 

1 Signal Path Compensation which compensates the signal pathways for 
gain and offset errors. 

2 Cable de-skew compensates for timing differences between any two 
cables. 

 
Once these calibrations are performed, they are not permanent.  It is 
recommended the signal path compensation be performed once a 
week and whenever the ambient temperature of the oscilloscope has 
changed by more than 50 C, whereas the cable de-skews can be 
performed before starting any new measurement session using the 
scope and cables. 
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Signal Path Compensation: 
This type of calibration can be done through the scope’s utilities menu.  
Select Utilities   Instrument Calibration. 
 

 
 
Figure 1: Utilities  Instrument Calibration Menu 

 
To perform this operation, all input cables to the scope channels must be 
disconnected. Ensure the Tektronix TCA-SMA (or TCA-292MM) input adapters 
are installed in all four channels and nothing is connected to the SMA inputs.  
 
This prevents transient voltages from leaking into the input amplifiers and ADC’s 
that could adversely affect the quality of the calibration routine.  Click on the 
“Calibrate” button. It takes about 10 minutes to get the calibration result. Final 
status should be “Pass” 
 

 
 
Figure 1: Signal Path Compensation 
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Cable de-skewing: 
 
Use the following procedure to compensate for timing differences between SMA 
cables and input channels: 
(This procedure is performed on a pair of cables at a time.) 

 
1. Connect TCA-SMA TekConnect adapters to all four channels of the 

scope. 
2. Press “Default Setup” 
3. Connect the SMA cables to the channels Ch1, Ch2, Ch3 and Ch4 of the 

scope. Use a torque-wrench to tighten the connections. (7-10 in lbs) 
4. Select Ch1 and Ch2 using buttons on scope front panel. 
5. Make sure that channels Ch3 and Ch4 are de-selected. 
6. Connect a power splitter to the “Fast Edge” output of the scope.  

(Refer to Figure 3 below.) 
 
 
 
 

                     
 

Figure 2: Cable de-skew connections 
 
 

7. Connect the cables from Ch1 and Ch2 to the power splitter outputs. 
8. Click on scope “Autoset” button on front panel 
9. Click “Ok” on the confirmation window. 
10. Adjust the Vertical Scale (increase it without any clipping) and Position 

controls for each channel so that the signals overlap and are centered on 
the display. 

11. Click Horiz/Acq->Horizontal/Acquisition Setup. 
12. Click on “Acquisition” tab. Refer to Figure 32 below. 
13. Select “Average” acquisition mode. 
14. Keep the “# of Wfms” as default which is 16. 

 
 

Power Splitter 
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Figure 4: Setting Average Mode 
 
 

 
15. Adjust the Horizontal Position so that a rising edge is triggered at the 

center of the display. 
16. Adjust the horizontal Scale (Lower time/pt) so that the differences in the 

channel delays are clearly visible. Refer to Figure 5 below. 
 

 
 

 
 
Figure 5: Visible Cable Skew 

 
 
 

17. Adjust the horizontal Position again so that the first rising edge is exactly 
at the center of the display. The short length (electrical length) cable is 
connected to this channel. 

18. Select Vertical   Deskew from the scope menu to open the Deskew 
control window. 

19. Select Ch2. 
20. Adjust the de-skew time for Ch2 so that its signal aligns with Ch1. 

 

Cable skew 
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Figure 6: Cable Skew Adjusted 
 
 

21. Remove the cable attached to Ch2 from the power splitter. Keep the other 
end of the cable attached to the scope input. 

22. Repeat above steps from 3 to 22 by connecting the cable from Ch3 to the 
de-skew attachment. Make sure to de-select Ch2 and select Ch3. 

23. Repeat steps from 3 to 22 by connecting the cable from Ch4 to the de-
skew attachment. Make sure to de-select Ch3 and select Ch4 

24.  De-skew procedure is complete when CH2, CH3 and CH4 have all been 
de-skewed to CH1. Take care to leave cable-scope connections 
undisturbed for the duration of testing on the DisplayPort source device. 

25. NOTE: If using differential probes instead of direct SMA cable connection 
to the scope, the procedure should be performed as above except using 
the cables connected to the + input side of each probe.    

De-skewed 
Cables 


